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Quality Management Service Information
Quality Management Documentation

The following documents contain additional information about QM 2.4:

■ Quality Management Installation Guide

■ Quality Management Administrator User Guide

■ Quality Management Desktop User Guide

■ Quality Management Error Code Dictionary

■ Quality Management 2.4 Release Notes
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Service Names and Executables

The following are the QM services as listed in the Windows Services utility.

Table 1. QM services and executables

Service Name Executable

Quality Management CTI Service splkjservice.exe (ctiservice.jar)

Quality Management DB Proxy Service splkjservice.exe (dbproxy.jar)

Quality Management DB Cleaner Service splkjservice.exe (dbcleaner.jar)

Quality Management LDAP Monitor Service LDAPMonSvr.exe

Quality Management Sync Service DirAccessSynSvr.exe

Quality Management Upload Controller SQMUploadController.exe

Quality Management Recording Service sqmservice.exe
6 October 2007
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Registry Entries

Site Setup

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\SQM\Site Setup

Table 2. Site setup registry entries 

Value Type Description

App Version string Version of the QM software

Callcenterlang dword Software localization language

FirstRun dword 1: QM Configuration Setup has run to 
completion

0: QM Configuration Setup has not run to 
completion

Install Directory string Base install directory for QM software

Installdir string Base installation directory for QM software

IOR Hostname string Host name or IP address of the QM services

LDAP Bind DN string User ID used to log into the LDAP service

LDAP Connection 
Timeout

dword Maximum time in seconds before a 
connection attempt times out

LDAP Heartbeat 
enabled

dword 1: LDAP heartbeats enabled

0: LDAP heartbeats not enabled

LDAP Heartbeat Retry 
Time

dword Heartbeat time, in milliseconds

LDAP Host 1 string Host name or IP address of the LDAP service

LDAP Host 2–5 string Host name or IP address of the backup LDAP 
service(s)

LDAP LCC string Default logical contact center

LDAP Port 1 dword LDAP service port number

LDAP Port 2–5 dword Backup LDAP service(s) port number(s)

LDAP Pwd string LDAP service user password (encrypted)

LDAP Recovery Retry 
Time

dword LDAP recovery time, in milliseconds
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Ident

HKEY_LOCAL_MACHINE\SOFTWARE\Spanlink\SQM\Ident

LDAP Request 
Timeout

dword Maximum time in seconds before an LDAP 
request times out 

LDAP Root string Root of the LDAP data

Table 2. Site setup registry entries — Continued

Value Type Description

Table 3. Ident registry entries 

Key Value Type Description

Admin (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

Playback (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

Record (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

CTI (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

DB (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

LDAP (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

Screen (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise

Voice (default) string 1 if the services/applications 
associated are installed; key is 
absent otherwise
8 October 2007



Logs and Debugging
Logs and Debugging

Applications and services use logging to report status and problems. Each application 
and service creates two files:

■ Log files (files with the *.log file extension) contain status messages and, if 
problems occur, warning and other error messages. All messages in log files 
are identified by an error code. See the Quality Management Error Code 
Dictionary for more information on error codes.

■ Debugging files (files with the *.dbg file extension) are empty when debugging 
is not enabled. When debugging is enabled (the default setting), the files 
contain diagnostic information that can help resolve issues.

Log and debugging files are located in the …\Cisco\WFO_QM\log folder on the client 
or server computer.

The default configuration settings limit each log and debugging file to a maximum of 
10 MB and 20 rolling files for QM services and 5 MB and 5 rolling files for 
applications. For example, when a service’s log or debug file reaches 20 MB, it is 
closed and renamed, and a new file is started.

C++ configuration files (files with the *.cfg extension) produce logs using this 
numbering scheme:

<name>0001.log is created and filled. 
<name>0002.log is created when the first file is full. 
<name>0001.log is cleared and reused when the second file is full. 
<name>0002.log is cleared and reused when the third file is full. 
And so on.

Java configuration files (files with the *.properties extension) produce logs using this 
numbering scheme:

<name>.log is always the file currently being filled. 
<name>.log.1 is the most recent filled file.

Debugging logs follow these same numbering schemes, but use the *.dbg file 
extension.

Setting the Default Debugger

When Microsoft SQL Server 2005 is installed on the Database Services server, 
Microsoft Visual Studio is also installed and configured as the default debugger on 
that server. It is recommended that you reset Dr. Watson for Windows as your default 
debugger. 
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To reset Dr. Watson as your default debugger:

1. On the server hosting the QM Database services, click Start > Run.

2. In the Open field, type drwtsn32.exe and click OK.

Dr. Watson for Windows starts.

3. Configure the settings to match those shown in Figure 1.

■ Accept the default Log File Path and Crash Dump locations.

■ Set the Crash Dump Type to Full.

■ Clear the Visual Notification check box.

4. Click OK.

Figure 1. Dr. Watson configuration settings.
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5. Click Start > Run.

6. In the Open field, type drwtsn32.exe -i and click OK.

You will see the confirmation dialog displayed in Figure 2.

Figure 2. Dr. Watson confirmation dialog.

7. Click OK to close the dialog box.

Dr. Watson is now set as your default debugger.

Log Message Formats

The following are the formats used by the various log and debug file messages. Each 
format is followed by an example. 

C++ and Java *.log file messages

<timestamp> <level> <error code> <error text>

2007-02-28 09:29:11.723 INFO ABCD1234 Successfully launched update.

C++ *.dbg file messages

<timestamp> [<thread ID>] <level> <text>

2007-02-28 14:51:13.723 DEBUG [0xaa8] CSqmcApiBase::_doRecovery: 
Connected to QM Controller.

Java *.dbg file messages

<timestamp> <level> [<thread name>] <class:line> <text>

2007-04-07 15:40:31.954 STACK [Th2] Init#:run:113 ClaimException…

Java (log4j) *.log file messages

<timestamp> [<thread name>] <level> [LINE-<number>] [<class:method>] 
<text>

2007-04-07 14:54:00,067 [Th2] INFO [LINE-1534] [Init:un] Started.
October 2007 11
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Configuration Files

Each application and service has an associated configuration file that controls logging 
and debugging. These files can be edited in a text editor such as Windows Notepad to 
change the logging and debugging parameters.

Configuration files are located in the …\Cisco\WFO_QM\config folder on the client or 
server computer.

CAUTION:  Edit configuration files only as described in this section. 
Improper changes can result in logging and/or program failure, 
including the possible loss of data. You might want to make a safety 
backup of any file you edit before you make changes to it.

The QM configuration and log files are displayed in Table 4.

Table 4. QM configuration and log files 

Service/Application Location Configuration File Log File

Backup and Restore server bars.properties bars.log

ContactDelete utility server ContactDelete.properties ContactDelete.log

DB Cleaner server dbcleaner.properties dbcleaner.log

DB Cleaner server splkSqmDBcleaner.cfg splkSqmDBcleaner.log

DB Proxy server dbproxy.properties dbproxy.log

DB Proxy server splkSqmDBproxy.cfg splkSqmDBproxy0001.log

DB Sync server dbsync.properties dbsync.log

File Transfer Servlet (FTS) server log4j-fts.properties fts.log

LDAP Monitor Service server LDAPMonSvr.cfg LDAPMonSvr0001.log

LDAP Monitor Service server slapd.cfg sladp0001.log

LDAP Monitor Service server slurpd.cfg slurpd0001.log

QM Administrator client admin.properties admin.log

QM Configuration Setup server, client postinstall.properties postinstall.log

QM CTI Service server ctiservice.properties ctiservice.log

QM CTI Service server splkSqmCTIservice.cfg splkSqmCTIservice0001.log

QM Desktop client qmdesktop.properties qmdesktop.log

QM Desktop Recording client splkService.cfg sqmService0001.log

QM Desktop Recording client sqmwinlogon.cfg sqmwinlogon0001.log*
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Enabling Debugging

By default, debugging is enabled. When debugging is enabled, keep in mind that the 
more detail the debugging threshold provides, the slower the performance of your PC 
and the bigger the size of the debug file. High debugging thresholds may also affect 
the performance of other applications running on your PC.

There are three types of configuration files:

■ C++ files that use the *.cfg extension

■ Java files that use the *.properties extension

■ Java files whose file name begins with “log4j”

Each type of file uses a different syntax to enable debugging. The procedures below 
describe the steps that must be followed for each type of file.

IMPORTANT:  Disable debugging when it is no longer needed.

The available debugging thresholds are displayed in Table 5. 

NOTE:  Not all thresholds can be used in all configuration files. See 
the procedures below for which thresholds can be used is particular 
files.

QM Reporting server log4j_SQMR.properties† SQMR.log

QM Uploader server dbUpload.properties dbUpload.log

QM Uploader server SQMUploadController.cfg SQMUploadController0001.log

Sync Service server DirAccessSynSvr.cfg DirAccessSynSvr0001.log

True Update client splkUpdate.cfg splkUpdate0001.log

* By default, this log file is located in the C:\Program Files\Common Files\QM\log\ folder.
† By default, this configuration file is located in the C:\Program Files\Cisco\WFO_

QM\Tomcat\webapps\SQMR\conf\ folder.

Table 4. QM configuration and log files — Continued

Service/Application Location Configuration File Log File
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To enable debugging in files with a *.cfg extension:

1. In a text editor, open the desired configuration file.

2. Under the section headed [Debug Log], set the debugging threshold to 
DEBUG, CALL, TRACE, or DUMP. For example:

THRESHOLD=DEBUG

The line might already exist or you might have to add a new line.

3. Save the configuration file. The change takes effect immediately. You do not 
have to restart the application or service.

To enable debugging in files with a *.properties extension:

1. In a text editor, open the desired configuration file.

2. Locate the line that starts with:

log4j.rootLogger=<threshold>#com.spanlink …

and replace <threshold> with DEBUG, TRACE, STACK, or DUMP. 

3. Locate the line that starts with:

log4j.appender.DBG.Threshold=<threshold>#com.spanlink …

and replace <threshold> with the same value you used in Step 2.

4. Save the configuration file. The change takes effect according to the 
splk4j.watch.check setting (by default, within 90 seconds). You do not have to 
restart the application or service.

Table 5. Debugging Thresholds  

Threshold Description

Debug Usually sufficient for diagnosing a problem. Will not affect system 
performance.

Call Tracks function entry and exit.

Trace Provides a large amount of diagnostic information. May affect 
system performance.

Stack Provides only stacktraces, which give more debugging information 
when errors and warnings occur.

Dump Provides a very large amount of detailed diagnostic information. 
Likely to affect system performance.

Off Turns off debugging.
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To enable debugging in log4j files:

1. In a text editor, open the desired configuration file.

2. Locate the line that starts with:

log4j.rootLogger=<threshold> …

and replace <threshold> with DEBUG or TRACE. 

3. Save the configuration file. 

4. Restart the application or service for the new setting to go into effect.

Disabling Debugging

It is important to disable debugging when it is no longer needed for diagnostic 
purposes. Debugging can affect the performance of your PC if it is left enabled.

To disable debugging in files with a *.cfg extension:

1. In a text editor, open the desired configuration file.

2. Under the section headed [Debug Log], set the debugging threshold to OFF. 
For example:

THRESHOLD=OFF

3. Save the configuration file. The change takes effect immediately. You do not 
have to restart the application or service.

To disable debugging in files with a *.properties extension:

1. In a text editor, open the desired configuration file.

2. Locate the line that starts with:

log4j.rootLogger=<threshold>#com.spanlink …

and replace <threshold> with STACK. 

3. Locate the line that starts with:

log4j.appender.DBG.Threshold=<threshold>#com.spanlink …

and replace <threshold> with OFF.

4. Save the configuration file. The change takes effect according to the 
splk4j.watch.check setting (by default, within 90 seconds). You do not have to 
restart the application or service.

To disable debugging in log4j files:

1. In a text editor, open the desired configuration file.

2. Locate the line that starts with:
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log4j.rootLogger=<threshold> …

and replace <threshold> with INFO. 

3. Save the configuration file. 

4. Restart the application or service for the new setting to go into effect.
16 October 2007
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ContactDelete Utility

The ContactDelete utility (ContactDelete.exe) is a command line tool that is installed 
on the Database Services server in the following location:

…\Cisco\WFO_QM\bin\ContactDelete.exe

It is used to permanently delete a specified contact from the database. 

Once this utility is run on a record, no calculations or contact lists will include the 
deleted contact. Other than the log file, there is no audit trail indicating the record was 
deleted. The deletion is permanent—the contact cannot be recovered.

The utility’s logs are defined in a properties file located at:

…\Cisco\WFO_QM\config\ContactDelete.properties

The log files are:

…\Cisco\WFO_QM\log\ContactDelete.log 
…\Cisco\WFO_QM\log\ContactDelete.dbg

Using the Utility

The syntax for this utility is as follows:

ContactDelete.exe <options> <uniqueID>

where:

<uniqueID>  . . . . . . . . Contact Unique ID of the contact to be deleted

-h,--help  . . . . . . . . . describes utility usage and displays any options

-f, --force . . . . . . . no prompt for deletion confirmation
October 2007 17
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Moving the Recording Storage Location

Follow this procedure to change the location where voice and screen recordings are 
stored. 

■ Voice Recordings: You can change the storage location to any local or external 
folder. It is not necessary that they be stored on the machine hosting the 
Voice Services. 

■ Screen Recordings: You can change the storage location to any local or 
external folder. It is not necessary that they be stored on the machine hosting 
the Screen Services. If the Screen Services and Voice Services are on the 
same server, you can elect to use the same path as is used for the voice 
recordings.

NOTE:  QM does not support storing recordings of the same type 
(voice or screen) in multiple locations. If you set a new storage 
location, all recordings of the same type must be moved to the new 
location.

The procedure requires some of the QM services and applications to be stopped while 
the process occurs. However, recording can still take place.

IMPORTANT:  The File Transfer Servlet that is part of the Voice and 
Screen services must run as a user (account) with access to whatever 
location you choose for recordings.

To move the voice and/or screen recording storage location:

1. Exit and close QM Administrator.

2. Stop the following QM services:

■ QM DB Proxy Service

■ QM Upload Controller Service

■ Tomcat

3. Back up the QM database and LDAP for disaster recovery purposes. See the 
section, “Backup and Restore” in the Quality Management Administrator User 
Guide for the backup procedure.

4. On the QM Services server, navigate to …\Cisco\WFO_QM\bin\ and 
double-click PostInstall.exe to start the QM Configuration Setup utility.

5. From the menu, choose Tools > Set Recording Home Directory to display the 
Recording File Storage Location window (see Figure 3).
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Figure 3. Recording File Storage Location window.

6. Select if you want to store recordings in a local or external storage location, 
and then enter or browse to the desired location in the Storage Location field.

■ Local Storage Location. A location that is physically part of the voice or 
screen server, such as an internal or external hard drive.

■ External Storage Location. A location that is not physically part of the 
voice or screen server, such as a network drive.

7. If you selected an external location, enter the username and password 
required to access that location. If the user is a domain user, enter the name 
with the format <doman>\<username>.

This user must meet these requirements:

■ The user must be known to the local server (must be a local user or a 
trusted domain user)

■ If the user is a domain user, the domain specified has to be trusted by the 
local server. This means the QM Recording Server being configured has to 
be on a domain that is (or is trusted by) the domain entered.

■ The user must be able to log on as a service
October 2007 19
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■ The user must have read/write access to both the external drive location 
entered AND the location where QM is installed on the local server.

8. Click OK.

9. Copy the recording files from the audio folder and all subfolders (for voice 
recordings) or from the video folder and all subfolders (for screen recordings) 
at the old location (default location is C:\Program Files\Common Files\ 
QM\recordings\) to the new location. The new location must have the audio 
or video folder and all its subfolders. For example:

Copy: …old location\audio\ 
…old location\video\

To: …new location\audio\ 
…new location\video\

10. Rename the old location audio folder and/or video folder for backup 
purposes. 

After you have verified that the files in the new location can be accessed (see 
the procedures below) and the move was successful, this folder can be 
deleted.

To verify that the moved recordings can be played back:

1. Restart the QM DB Proxy Service and the Tomcat service. 

2. Start QM Desktop and play back at least one QM recording (if applicable) and 
one archive recording (if applicable). 

3. If the playbacks are successful, restart the QM Upload Controller.

To verify that new recordings are uploaded to the new location:

1. With archiving enabled, make a test call from a phone that is configured to be 
recorded.

2. In QM Desktop, download that call on demand on the Archive tab and play it. 
You will be able to do this if the call is uploaded to the correct location.

NOTE:  If you do not enable archiving, you must wait for the normal 
uploading cycle to occur before you can review the call on the 
Recording tab. 
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Audit Trail Error Messages

Table 6 describes the audit trail error messages that can appear in the Service Status 
and System Status reports generated through QM Desktop. 

Table 6. Audit trail error messages 

Message Description/Action

CCM detected is not configured in 
QM: <Cisco Unified CM IP 
address>.

Description: The Cisco Unified CM detected is not 
configured in QM. No recording will take 
place.

Action: Check the CallManager Cluster settings in 
QM Administrator, and ensure that the 
agent phone is homed to the correct Cisco 
Unified CM.

Conversion from raw to spx failed. Description: Failed to convert the voice file from *.raw 
to *spx format.

Action: QM Recording will convert the file later.

Extension number(s) is/are not in 
the inclusion list: <extension 
number(s)>.

Description: The extensions from the agent’s phone 
cannot be found in the inclusion list. No 
recording will take place.

Action: Add the extension(s) you want to record to 
the inclusion list.

Free Space <path, current (Mb)>. Description: Free space checks should occur 
periodically. The default configuratio nputs 
the check at every 18 seconds when free 
space is less than or equal to 32000 Mb, 
and every 10 minutes when free space is 
greater than 32000 Mb. To be approved for 
upload, free space must be greater than or 
equal to the file size plus 90% of hte failure 
threshold. The default failure threshold is 
1000 Mb. FTS uploads also write to the QM 
databsae EventAudit table. FTS has 
hardcoded warning thresholds of 32000, 
160008000, and 4000 Mb. Each time a 
warning threshold is breached, the 
appropriate message is written to the 
EventAudit table and to the fts.log file.

Action: None.
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Free Space: Checking free space 
failed. Free space checking has 
been disabled.

Description: At the startup of the Tomcat service on the 
Voice and Screen servers, if FTS is unable 
to run the free space check, it turns off 
future free space checks.

Action: Troubleshoot why FTS was unable to run 
the free space check.

Free Space: Checking free space 
has been manually turned off.

Description: FTS Free space checking has been turned 
off by the user. By default, it is enabled.

Action: FTS will no longer check free space for 
storage on the Voice and Screen servers. 
As a result, these servers might fill up until 
there is no more room for more recordings. 
The free space check should be enabled.

Free Space: Prior Warning 
Cancelled. <path, current (Mb)>.

Description: A prior free space warning has been 
cancelled.

Action: None.

Logged in with version: <current 
version>.

Description: A QM user with the specified version of QM 
Recording installed has logged in.

Action: None

Logged out. Description: A QM user has logged out.

Action: None.

MAC address is not associated 
with the JTAPI user: <MAC 
address>.

Description: The MAC address for the agent’s phone is 
not associated with the JTAPI user. No 
recording will take place.

Action: Be sure the phone is correctly configured in 
the Cisco Unified Communications 
Manager.

QM CTI service is connected: <CTI 
Server IP address>

Description: QM Recording is connected to the QM CTI 
service.

Action: None.

QM CTI service is disconnected: 
<CTI Server IP address>

Description: QM Recording is not connected to the QM 
CTI service. No recordings will take place.

Action: Be sure the QM CTI server IP address is set 
correctly in QM Administrator and that the 
QM CTI service is running.

Table 6. Audit trail error messages — Continued

Message Description/Action
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QM recording software is ready to 
record.

Description: QM Recording is ready to record.

Action: None.

Recorded (voice): <number of 
voice files>.

Description: The number of recorded voice files ready to 
be uploaded.

Action: None.

Recorded (voice/screen): 
<number of voice and screen 
files>

Description: The number of recorded voice and screen 
files ready to be uploaded.

Action: None.

Screen recording failed to start. Description: Screen device failed to start recording.

Action: Restart QM Recording; systems will 
initialize the screen device.

Service is stopped while user has 
not logged out: <user name>.

Description: QM Recording is stopped while the user is 
still logged in. No recording will take place.

Action: Restart QM Recording or reboot the 
computer.

This user must belong to a team 
to record: <domain\username>.

Description: The specified user does not belong to a 
team. No recording will take place.

Action: Assign the user to a team in the ACD and 
synchronize the data with QM using QM 
Administrator to initiate the synchronization 
process.

Unable to retrieve phone 
information.

Description: QM Recording was unable to detect the 
MAC address for the connected phone. No 
recording will take place.

Action: Be sure the agent’s phone and computer 
are connected in accordance with the 
section, “Desktop Recording 
Requirements” in the Quality Management 
Installation Guide.

Uploaded (voice): <number of 
voice files>

Description: The number of recorded voice files that 
have been uploaded to the server.

Action: None.

Uploaded (voice/screen): 
<number of voice and screen 
files>

Description: The number of recorded voice and screen 
files that have been uploaded to the server.

Action: None.

Table 6. Audit trail error messages — Continued

Message Description/Action
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Uploads Stopped: Not enough 
free space <path>.

Description: FTS has stopped uploading recordings to 
<path> because the location at <path> is 
full.

Action: Add more storage.

User is not configured to record: 
<user name>.

Description: The logged-in user is not configured in QM. 
No recording will take place.

Action: User QM Administrator to configure the 
user.

Voice recording failed to start. Description: Voice device failed to start recording.

Action: Restart QM Recording; systems will 
initialize the voice device.

Zero byte file uploaded: <file 
name>.

Description: The size of the uploaded file is zero.

Action: None.

Table 6. Audit trail error messages — Continued

Message Description/Action
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Troubleshooting

Problem Desktop recording fails.

Symptom.  No recording files are in the C:\Program 
Files\Common\QM\Recordings folder on the desktop where recording 
is failing,

Cause.  The DNS has not been configured to resolve IP addresses and 
host names.

Solution From the PC where desktop recording is failing, open a command 
window and enter ping -a <Unified CM IP address>. If the ping cannot 
resolve the Unified CM IP address to the correct Unified CM host name, 
then neither can QM Desktop Recording. Configure the DNS so that 
host names and IP addresses are resolved.

Problem QM historical data is lost.

Symptom.  Historical data that was present is no longer in QM.

Cause.  The location of the ICM Logger Database was changed through 
QM Configuration Setup. All information that was contained in that 
database is no longer available for QM to access.

Solution Restore the original settings in the ICM Logger Database window in QM 
Configuration Setup. If problems persist, contact Cisco technical 
support.

Problem The client application installations do not download when the links on 
the installation web page are clicked.

Symptom.  When the install program link is clicked, a “HTTP 404—File 
Not Found” error is displayed.

Cause.  QM Site Configuration was not completed successfully on the 
Base services server.
October 2007 25



Quality Management Service Information
Solution On the QM Base services server, start QM Configuration Setup. In 
Windows Explorer, navigate to the C:\Program Files\Cisco\WFO_
QM\bin folder and double-click PostInstall.exe.

If Configuration Setup starts in Initial Mode, it was not completed 
correctly. Go through each window and make sure that all required data 
is entered, and then click Finish.

If Configuration Setup starts in Update Mode, start QM Configuration 
Setup. From the menu bar, choose File > Reset Client Installs. This 
places the client install files in the default location, and reconfigures 
them to use the default setting for the IP address of the LDAP server.

Try to install the client applications from the installation web page 
again. If the problem persists, contact technical support.

Problem On some windows in QM Administrator (for instance, the questions area 
on the Evaluation Form Templates window), buttons appear cut in half.

Symptom.  Buttons are not displayed correctly.

Cause.  The Display DPI setting is set to something other than Normal.

Solution In the Windows Control Panel, start the Display utility. On the Settings 
tab, click Advanced. In the resulting Plug and Play Monitor Properties 
dialog box, select the General tab and make sure the DPI Setting is set 
to Normal size (96 dpi). Click OK twice to save and apply your settings.

Problem The Sync service is not synchronizing databases.

Solution Ensure that the IP address for both Side A and Side B are correct. The 
IP address and “side” are tied together and are not interchangeable. 
For example, you cannot specify the IP address for Side B in the Side A 
field.

Problem In QM Administrator (Personnel > User Administration > Link Selected 
Users) Active Directory users are not found if the domain is identified by 
the host name. When a user is selected, the Link Selected Users dialog 
is launched and domain information is displayed. However, when Find 
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is clicked, an error message displays indicating that no data is 
available.

Cause.  In Site Configuration, the Active Directory domains were added 
using the host name to identify the AD connection. The connection was 
validated and the domain configuration was saved. 

Solution Edit the domain configuration to change the host name to an IP 
address. Once changed, AD data can be found in the Link Selected 
Users window. If you want to continue using host names, add the host 
name to the DNS path to ensure that the host name is reachable by all 
computers.

Problem Playback of screen recordings fail. Voice recordings are unaffected. The 
system suffered a power failure but was restarted successfully.

Solution The path of the video folder on the Screen server changed to an 
incorrect location. For example, Configuration Setup displays the 
screen recording storage path as C:\Program Files\Common 
Files\QM\recordings\video when they are actually located at 
E:\Program Files\Common Files\QM\recordings\video. Correct the 
folder path to the true location in Configuration Setup and screen 
recordings will play back.

Problem The message, “Error 1500. Another installation is in progress. You must 
complete that installation before continuing with this one.” is displayed 
on a client desktop. 

Cause.  This message can appear when a user attempts to manually 
upgrade QM Desktop Recording and Automatic Updating has already 
initiated an upgrade. The upgrade is running silently in silent mode and 
the user was unaware of it. 

Solution Wait five minutes to allow the automatic upgrade to complete. Then 
check the Add or Remove Programs utility in Control Panel for the 
version of the installed application. If the version is not correct, 
manually install the upgrade.
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Problem Reports in CSV, PDF, and XLS format do not open in Microsoft Internet 
Explorer 7.

Symptom.  A dialog to save the report opens but closes again very 
quickly.

Solution Clear the Confirm open after download check box for the CSV, PDF, and 
XLS file types. To do this, follow these steps for each file type:

1. Double-click My Computer.

2. On the Tools menu, choose Folder Options.

3. Select the File Types tab.

4. Under Registered File Types, select the file type, and then click 
Advanced.

5. Clear the Confirm open after download check box, and then click 
OK.

Problem An agent can view calls on the Dashboard tab but not on the 
Recordings tab.

Cause.  This happens when any of the following has occurred:

■ The agent’s team is not in a group

■ The agent’s team is deleted so that the agent is reassigned to the 
default team

■ The agent is deleted from the Cisco Unified Communications 
Manager

Solution To see the calls on the Recordings tab, do one of the following (as 
appropriate to the individual situation): add the team to a group, add 
the agent to a team, or add the agent in Cisco Unified Communications 
Manager.
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Problem The message, “Conversion from raw to spx failed” is seen multiple 
times in the Service Status report, but all the recordings for the 
specified agent for that day were uploaded correctly.

Solution If the staging process that occurs after the configured End Of Day is 
interrupted before it is completed, you might see this error message in 
the Service Status report. 

Part of the staging process involves converting the *.raw files to *.spx 
files. The *.spx files are moved to the Staging folder, while the *.raw 
files are deleted from the Daily folder. If the staging process is 
interrupted after some files have been converted and the *.raw files 
have been deleted, when the staging process resumes, it starts from 
the beginning so that it appears to fail converting the files that it 
already processed correctly before the interruption. 

An example of an interruption may include rebooting the PC or 
restarting the Desktop Recording service during the staging process. In 
this scenario, no recordings are lost.

Problem Unable to record calls from a SIP phone right after rebooting the PC.

Solution To detect the connected IP phone, QM Recording monitors the 
heartbeat messages between the Cisco Unified Communications 
Manager and the IP phone. It may take up to 6 minutes after QM 
Recording starts to properly identify a SIP phone.

Problem While running QM Configuration Setup after installing QM, the following 
error message is received: “Unable to get information from SQL 
Server”. You are using SQL Server 2005 and a named instance, not the 
default instance.

Cause.  When SQL Server 2005 is installed, it also installs the SQL 
Browser Service. This service is set by default to be started manually, 
not automatically. It must be running in order for Configuration Setup to 
run successfully.

Solution Change the SQL Browser Service’s Startup Type from Manual to 
Automatic in the Windows Services utility in Control Panel, and then run 
QM Configuration Setup again.
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If you are upgrading QM from an earlier version. If, after starting the 
SQL Browser Service, you still receive the error message, call technical 
support for assistance.

If you are installing QM for the first time. If, after starting the SQL 
Browser Service, you still receive the error message, remove the 
following files from the C:\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL\Data folder:

■ SQMDB.mdf

■ SQMDB_log.LDF

■ SQMREPORTDB.mdf

■ SQMREPORTDB_log.LDF

and then run QM Configuration Setup again.

IMPORTANT:  Do not remove these files if you are upgrading 
QM. If you do, you will lose data that was present in the 
previous version of QM. In an initial installation, there is no 
QM data yet, so these files are empty and can be removed.
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